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GEODICT GUI, MENU, AND TOOLBAR 

This handbook describes the basic elements of the GeoDict GUI (Graphical User 
Interface). The standard GUI is partitioned into: 

◼ Menu bar (see page 4), that gives access to the main features of GeoDict, 

◼ Toolbar (see page 3), that provides several shortcuts to the most common tools, 

◼ Project Status section (see page 43), where information about the current 
project is shown and the loaded structure and volume fields can be edited in the 

right-click menu, 

◼ Module section (see page 59), where commands and their options for the chosen 

module can be selected, 

◼ Visualization area and View Controls panel (see page 61), where the structure 

is shown and visualization settings can be made,  

◼ Sidebar (see page 68), where modifications of the visualization or the structure 

can be made, 

◼ Recent Files and Folders section (see page 2), which shows the last used folders 

and files on the start screen, 

◼ Console and Notifications (see page 90), that display messages from GeoDict.  

 

Visualization area and View Controls 

Toolbar 

Module section 

Console & Notifications 

Menu bar 

Recent Files and Folders 

section 

Sidebar 

Project Status 
section 

Hardware Status section 
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At the program start, the heading for the Module section is for one of the licensed 

modules, e.g., the FiberGeo module. The Visualization area shows the program’s 
splash screen. 

When a structure model is displayed, the View Control panel with several tabs 

appears above the Visualization area to control the visualization of the structure or 
the results computed for it. 

 

This handbook does not describe all features that are accessed through the GUI. 

Features described in separate handbooks of the User Guide are not described here 
again. In this case, only a link to the corresponding handbook is provided.  

A first overview of how a basic workflow in GeoDict might be performed is described 

in the First steps in GeoDict tutorial. 

 

RECENT FILES AND FOLDERS 

If no structure is in memory and the initial splash screen is shown, the Recent Files 
and Recent Folders sections are visible below. There, the Name, Size and date 
when it was last modified are shown. Clicking on a file opens it directly in the 

Visualization area or the Result Viewer. Clicking on a folder changes the current 
project folder.  

 

 

 

Visualization area 

View Controls 

http://www.geodict.com/Support/tutorials.php
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TOOLBAR 

The Toolbar displays tools for selected functions, mostly included in the Menu bar, 

frequently used in GeoDict. Resting the mouse pointer over a tool for a moment 
prompts a tool tip explaining the function. 

The selecting and editing functionality of Voxel Selection, GAD Object Selection, Paint 
and Metrology are part of the GUI Sidebar, and thus, are explained below starting on 

page 68.  
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MENU BAR 

The Menu bar contains the menus: File, Import, Model, Analyze, Predict, Export, 

View, Settings, Macro, GeoApp, Cloud & Queue, and Help. Their functions are 
accessible by scrolling down in the pull-down menus.  

 

FILE 

The File menu entries are organized into panels: 

 

OPEN FILES, PACK AND LOAD RESULTS, PROJECT FOLDER 

OPEN STRUCTURE (*.GDT, *.GAD) 

Select Open Structure (*.gdt, *.gad) … to browse for and open a saved generated 

structure file in GDT format (GeoDict compressed format), in GAD format (GeoDict 
analytic data) or in an index image format (*.leS and *.g32). Such files are usually 
saved and, thus, located in a personal project folder created by the user for the 

current project. Loading a *.leS or *.g32 file with Open Structure imports the file 
as a structure in GeoDict, assigning the indices to the 256 material IDs. First, the 
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index 0 is assigned to ID00. Then, the other indices are assigned to the other 255 IDs 

equally. That means, index 01 gets ID 01, index 02 gets ID 2 and so on till index 255 
gets ID 255. If more than 256 indices are contained in the *.g32, then the IDs are 
assigned again starting with ID 01 for index 256. Loading such files with File → Load 

Volume Field instead (see page 6), loads it as an index image. 

The toolbar icon  is the shortcut to open structures. 

IMPORT STRUCTURE (*.GDT) 

With Import Structure (*.gdt)… only files in GDT format can be loaded into 

GeoDict. In contrast to Open Structure, after selecting a file to open, the Import 
Structure dialog offers several options, such as changing the voxel length and 

cropping the structure. 

For a file which contains analytical information of the microstructure, the user can 
decide to Import the structure as Analytical Structure or to only Import as Voxel 

Structure. Importing as analytical structure allows, e.g., to change the origin or to 
rotate the structure. The options are explained in more detail in the Import GAD data 

section of the GadGeo handbook. 

If Import as Voxel Structure is checked, the dimensional values of NX, NY, NZ 

cannot be changed. The Voxel Length can be changed and has no impact on the 
number of voxels. The unit can be selected from the pull-down menu in the upper 
right corner of the dialog. 

A sub-region to load can be set by adjusting the sliders for CropX, CropY and CropZ 
or entering the exact voxel number in the corresponding boxes. The resulting Length 

is shown on the right in units of voxels. 

 

OPEN RESULTS (*.GDR) 

Select Open Results (*.gdr)… to open and load result files in GDR format (GeoDict 
results), obtained from a previous run of a GeoDict solver or structure generator, and 

saved in the project folder.  

The toolbar icon  is the shortcut to open results. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GadGeo&release=2024&heading=Import
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CLEAN-UP / PACK RESULTS (*.GDR) 

Select Clean-Up / Pack Results (*.gdr)… to delete or compress additional files 
that are saved in the result folder of the chosen result file.  

 

When the Pack Mode Clean-Up is selected, you must decide for every file type in the 
result folder if it should be kept or deleted.  

When choosing Pack, select all the file types which should be contained in the 
compressed ZIP-folder. The original files are still present in the results folder. Select 
Delete Original Results Folder after Packing to also delete the original files inside 

the folder. 

LOAD VOLUME FILE 

Select Load Volume File… to open volume files and visualize the contained volume 
fields, e.g., *.vap files (velocity and pressure) located in the result folders. You can 

open and load result files for visualization in numerous formats. 
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In the opening Loading volume file dialog, select the volume fields you want to 

load. Select Allow clipping by distance additionally computes a distance field using 
a signed Euclidean distance transform (see MatDict handbook for more information). 
Later, the distances can be used to threshold the other loaded volume fields. 

If a compressed volume field is opened, it is possible to load the field in compressed 
form or to decompress it during loading. A compressed field is saved when checking 

Write Compressed Volume Fields under the Solver tab of the LIR Solver Options 
dialog. Notice, that some operations and visualization features of volume fields (e.g 
the visualization of the adaptive grid) are available only if the field is loaded in 

decompressed form. It is also possible to load a volume file in compressed form and 
decompress it later. In the project status section on the left, right click on the volume 

image and choose Decompress.  

 

Check Keep existing Volume Fields, if already loaded volume fields should be kept 

in the GeoDict memory. 

With the buttons Check all and Uncheck all, the fields from the volume file you want 
to load can be selected or deselected at once. 

In the View File Header tab you can see the header of the volume file. The header 
provides information about the domain size, voxel length, boundary conditions, and 

many more. Nothing can be edited in this tab, only the available information, 
depending on the volume file type, is shown. When opening a volume file with a text 
editor the header is the only readable part of this file, but it is more comfortable to 

view it during the import in GeoDict. Moreover, for large volume files, a text editor 
needs a long time to open the file or is even unable to open it. 

Clicking OK starts the import of the volume file. 

LOAD PARTICLES 

Select Load Particles… to open and visualize particle trajectories and particle 
positions for FilterDict or AddiDict simulations (*.gpt and *.gpp files). This option is 

only available if a structure is currently loaded into GeoDict. 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MatDict&release=2024&heading=EDT
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OPEN RECENT FILE 

Select Open Recent File… to choose a file from a list. This list of files opened or 
created in the last GeoDict session is shown in the Recent Files section (see page 2). 

CHOOSE PROJECT FOLDER 

For Choose Project Folder a sub-menu opens when hovering above. Click Select 
Project Folder… to open the Choose Project Folder dialog. Find the path to a 
previously created and already listed project folder, or right-click in the dialog to 

create a new project folder to save the results and settings files produced with 
GeoDict. 

 

Follow Choose Project Folder → Options… to set up how the project folder is 

selected at the start of GeoDict. Last Project Folder, or a Fixed Project Folder can 
be selected.  

 

Click Open Project Folder… to open the currently selected project folder with the 

Windows Explorer. Below, if available, the last project folders are listed as it is done 
in the Recent Project Folder section (see also page 2). 

The toolbar icon  is the shortcut to choose the project folder. 
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The project folder will contain the files with the generated structures and the result 

files from the solvers’ computations.  

The location of the project folder is defined by the user at his/her convenience. The 
initial project folder for the first start of GeoDict, is located in Windows, by default at  

 

SAVE STRUCTURE, IMAGE, VIDEO, TRIANGULATION, OR VOLUME FILE 

 

SAVE STRUCTURE 

Select Save Structure as… to save the generated structure in the supported file 

formats (GDT, GAD, leS, and RAW).  

The toolbar icon  is the shortcut to this function. 

 

The automatically chosen folder to save the file containing the structure data is the 
current project folder. But it is also possible to choose another location. 

SAVE STRUCTURE AS IMAGE STACK 

With Save Structure as Image Stack (*.png)… each Z-slice can be saved as a 

*.png file. Each material ID is converted into a gray value. In the options menu, a 
Result File Name can be specified. The *.png files are then saved into a folder with 

the same name and a result file will be created. 
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SAVE IMAGE 

Choosing Save Image as… saves the current content of the visualization area in the 
supported file formats (*.png, *.jpg, *.xpm, *.xbm, *.bmp, *.pgm, *.ppm, and 

*.pbm) in the project folder.  

The toolbar icon  is the shortcut to this function. The opening dialog is different 

depending whether 2D view or 3D view was previously selected. 

For 2D images, in the Save Image dialog that opens, select first where to place the 
legend in the image.  

 

◼ Choose Attached to place the legend outside of the image but attached to it. If 
this is selected, the resolution can be selected automatically or manually by 

defining a zoom factor. Uncheck the Automatic Resolution box, to set the zoom 
factor.  

 

◼ Choose Overlay as the Legend Placement to allow that the legend overlaps the 
image. In this case, the user can choose to save the image with the Current 
Resolution, to define a Custom Resolution or to use the Preset resolution 

values that fits best. 

A preview of the image is shown in the right part of the dialog. Click OK to select the 

settings. 
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Choose a file name and an image format and save the image by clicking Save. 

 

For 3D images, choose the resolution to save the image with the Current 

Resolution, define a Custom Resolution or use a Preset resolution. 

Select Crop all empty space to reduce the image size by removing all borders in 

background color.  

If this is selected, the image can be embedded in borders with the background color 

(Embed after cropping). The number of pixels or a percentage value for each 
border can be defined separately in this case.  

Finally, check Save with transparent background to save the image without a 

background color. 
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Additionally, there is a shortcut to copy the content of the visualization area to the 

clipboard. Press CTRL+C to copy the whole visualization area with the same 
resolution as it is currently displayed. The result is the same as if you took a 
screenshot of the visualization area. The combination CTRL+C works both in 2D view 

and 3D rendering. 

With CTRL+X, an image of only the current domain is copied to the clipboard. The 

image has a 1:1 resolution of the structure, meaning that 1 voxel will be represented 
by 1 pixel in this image. 

 

  

CTRL+X CTRL+C 
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Starting with GeoDict 2024 Service Pack 2, CTRL+X also works in 3D rendering, but 

it copies the whole visualization area with transparent background to the clipboard.  

 

   

CTRL+X CTRL+C 
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Save Video 

Selecting Save Video as… opens the Create Video dialog, which allows choosing 
preset scripts that execute the making of a video with appropriate standard settings.  

The toolbar icon  is the shortcut to the Create Video dialog. The preset video 

scripts are organized in the two tabs 2D and 3D.  

 

Clicking on Generate Videos opens the Save Videos dialog, where the output 

options like the video file name can be entered. The video is then created without any 
modifications of the underlying script.  
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Click Open Video Editor to open the Video Editor for modifications. Edit Video 

Preset allows to change the description of the video preview.  

The following preset movie clips are available:  

◼ In 3D: Clipping X, Clipping Y, Clipping Z, Fly-by, Follow Particle, Particle 

Animation, Rotate X, Rotate Y, Rotate Z, and Streamlets. Also given is the 
option to import settings from the Video Dialog 3D to be listed in the preset video 

scripts (Import as Video GeoApp), to produce a 3D video using 2D images 
from a stack of scanned images (Create Video from Image Stack), and to 
simply open the Video Dialog 3D editor without loading a specific preset video 

script (Open Editor). 

◼ In 2D: Back To Front (all slices), Back To Front, Front To Back (all slices), 

Front To Back, Import as Video GeoApp, Create Video from Image Stack, 
and Open Editor. 

See the Create Videos handbook for more details about creating videos in GeoDict. 

 

SAVE TRIANGULATION 

Select Save Triangulation as… to save triangulations obtained by creating a mesh 

through MeshGeo or by importing in ImportGeo-CAD. More information can be found 
in the ExportGeo-CAD with MeshGeo handbook. 

SAVE VOLUME FILE 

Select Save Volume File as… to save simulation results in several file formats. For 

example, after running a flow simulation with FlowDict, select a name to save the 
field of the velocity in X-direction as raw float data (*.vol) or GeoDict universal file 
(*.guf). 

 

 

The use of Save Image as... and Save Video as… are excellent and easy-

to-use choices when the user intends to present to the public structures and 

visualized results after working with GeoDict. 

The high resolution achievable when saving images or videos this way is 

suitable for press-ready flyers and posters. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=CreateVideos&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MeshGeo&release=2024&heading=Save
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DISCARD STRUCTURE OR SIMULATION RESULTS 

Selecting Discard Structure and Volume Files makes the structure, and all 
simulation result fields available for this structure, disappear from memory and from 
the Visualization area. The initial GeoDict splash screen appears in the visualization 

area instead. 

In the example shown here, a fiber structure is loaded in GeoDict, together with the 

volume fields of velocities in X-, Y- and Z-direction, loaded from the .vap file of a flow 
simulation.  

Clicking Discard Structure and Volume Files removes the structure, and the 

simulation result fields (volume fields) from the memory. 

 

Selecting Discard Volume Files eliminates only the simulation result fields (volume 
fields) that are currently loaded from the memory. The structure displayed in the 

visualization area is not deleted. 
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In the same way, for a particle simulation result (created with FilterDict or AddiDict), 

if particle trajectories or positions are available in GeoDict memory, Discard 
Particles removes the particle information from memory. 

A structure in STL format (Stereosurface triangulation language), imported with 

ImportGeo-CAD, and shown in the Visualization area, is deleted from memory when 
Discard Triangulation is selected.  

CLEAR RECENT FILES / FOLDERS 

Clicking Clear Recent Files / Folders clears the list of Recent Files and Recent 
Project Folders shown in the GUI. 

MANAGE FLOATING LICENSE, CHOOSE LICENSE FILE, AND QUIT 

Clicking Manage Floating License… allows a floating license user to choose which 

of the licensed modules they would like to use in this session. Deselected modules 
will be shown as unlicensed in GeoDict’s menu, and their license will then be free for 
other users to use. More information can be found in the Download, Installation and 

Licensing handbook. 

Select Choose License File… to select a license file, e.g., to change the license from 

evaluation to purchased or leased license, to upgrade the license for another term, or 
to request a new license file following the procedure explained in Licensing GeoDict 
in the Download, Installation and Licensing handbook. 

 

Selecting Quit opens the Exiting GeoDict dialog, where you have to confirm with 
Yes to end the current GeoDict session. Selecting No does not end the GeoDict 

session. GeoDict can also be terminated by clicking the close button  in the title 
bar. The exiting dialog also opens here to prevent you from accidentally closing the 
session. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=DownInstallLicense&release=2024&heading=ManageFloatingLicense
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=DownInstallLicense&release=2024&heading=ManageFloatingLicense
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=DownInstallLicense&release=2024&heading=LicenseDialog
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IMPORT 

Accessible from the menu bar are interfaces to import image and structure files into 
GeoDict (ImportGeo). Modules that have not been licensed appear under unlicensed 

in the list.  

Start an ImportGeo module by clicking Import in the menu bar and selecting one of 
the sub-modules available to import a file into GeoDict. If a module is selected, a dot 

appears in front of it in the module list and the module section changes to show this 
module. 

 

◼ ImportGeo-Vol is used to import most image file formats for 3D visualization, 3D 
image processing and segmentation. On imported gray value images, ImportGeo-
Vol can perform 3D processing with a variety of filtering techniques. Subsequent 

segmentation converts gray values to material index values typically stored in the 
GeoDict Binary file format. For more information, check the ImportGeo-Vol 

handbook. 

◼ ImportGeo-CAD imports surface triangulation files that describe only the surface 
geometry of a three-dimensional object. During import, these files can be 

converted to 3D material models. For more information, check the ImportGeo-
CAD handbook. 

MODEL 

The Model menu gives access to the list of modules for digital material modeling that 
are included in the user’s license. GadGeo, ProcessGeo, and LayerGeo can always be 

used because they are included in the GeoDict Base Package. Other modules that 
have not been licensed appear in the list under unlicensed.  

The GeoDict modules for digital material design available for licensing are: 

 

Complete information on the individual modules is found in the corresponding 
handbooks: 

▪ FiberGeo handbook 

▪ PaperGeo handbook 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ImportGeoVol&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ImportGeoCAD&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ImportGeoCAD&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=FiberGeo&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=PaperGeo&release=2024


GeoDict GUI, menu, and toolbar 

20  GeoDict 2024 User Guide 

▪ GrainGeo handbook 

▪ FoamGeo handbook 

▪ WeaveGeo handbook 

▪ GridGeo handbook 

▪ PleatGeo handbook 

▪ GadGeo handbook 

▪ ProcessGeo handbook 

▪ LayerGeo handbook 

▪ MeshGeo handbook 

 

ANALYZE 

The Analyze menu gives access to the list of modules for digital material analysis 
that are included in the user’s license. Modules that are not licensed appear in the list 

under unlicensed. 

The GeoDict modules for digital material analysis available for licensing are: 

 

Complete information on the individual modules is found in the corresponding 
handbooks: 

▪ FiberFind handbook 

▪ GrainFind handbook 

▪ PoroDict handbook 

▪ MatDict handbook 

▪ GeoDict-AI handbook 

 

PREDICT 

The Predict menu gives access to the list of modules for the prediction of material 

properties that are included in the user’s license. Modules that are not licensed appear 
in the list under unlicensed. 

GeoDict modules available for prediction of material properties are: 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GrainGeo&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=FoamGeo&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=WeaveGeo&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GridGeo&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=PleatGeo&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GadGeo&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ProcessGeo&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=LayerGeo&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MeshGeo&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=FiberFind&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GrainFind&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=PoroDict&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MatDict&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GeoDictAI&release=2024
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Complete information on the individual modules is found in the corresponding 

handbooks: 

▪ DiffuDict handbook 

▪ ConductoDict handbook 

▪ FlowDict handbook 

▪ ElastoDict handbook 

▪ FilterDict handbook 

▪ AddiDict handbook 

▪ SatuDict handbook 

▪ AcoustoDict handbook 

▪ BatteryDict handbook 

EXPORT 

Accessible from the menu bar are interfaces to export structure files, images, and 
simulation results from GeoDict (ExportGeo) to many other software packages. 

To export a GeoDict file to other formats, select Export in the menu bar, and choose 
between Export as CAD (MeshGeo), Export to Fluent (ExportGeoFluent), and Export 

to Abaqus (ExportGeoAbaqus).  

 

With ExportGeo, structures from GeoDict can be exported to other formats so that 
files produced by the GeoDict user are compatible with other software and can be 
used for customized workflows:  

▪ ExportGeo-CAD converts voxelized or analytic structures to commonly used 
surface triangulation and CAD formats like STL, VRML, or Parasolid. 

▪ ExportGeo-Fluent and ExportGeo-Abaqus convert voxelized data to formats for 
flow and heat computations with Fluent™ or elasticity computations with Abaqus. 

For complete information on interfaces from GeoDict, see the ExportGeo-CAD / 
MeshGeo handbook, the ExportGeo-Fluent handbook, and the ExportGeo-Abaqus 

handbook. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=DiffuDict&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ConductoDict&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=FlowDict&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ElastoDict&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=FilterDict&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=AddiDict&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=SatuDict&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=AcoustoDict&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=BatteryDict&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MeshGeo&release=2024&heading=CreateMesh
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MeshGeo&release=2024&heading=CreateMesh
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ExportGeoFluent&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ExportGeoAbaqus&release=2024
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VIEW 

After modeling a structure, either by generating it in GeoDict or after importing 3D 
µCT or FIB/SEM images, choosing between the View menu entries changes the 

visualization settings. A shortcut to many of these parameters can also be set through 
the Visualization Side Bar, as explained shortly below and in more detail in the 
Visualization handbook. 

 

The View menu allows to: 

◼ choose the visualization type to be 2D Cross Section (SEM), or 3D Rendering, 

with more settings under 3D Structure Renderer and the 3D View Ratio. 

◼ display the Visualization area in Full Screen which makes the Visualization area 

occupy the entire computer screen. Pressing the Esc key on the keyboard returns 
the program to the normal display. 

◼ select which components are displayed in the visualization. 

◼ choose the Legends / Overlays to be displayed. 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2024
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Some of these options are only accessible when choosing to visualize in 3D 

Rendering or when visualizing solver results (Volume Field, Streamlines, 
Particles, Triangle Mesh, Schlieren, Arrows, and Tensors). 

Choose Legend / Overlays → Detailed Settings to access the Visualization Side 

Bar. Its functionalities are explained in the Visualization handbook. 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2024
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SETTINGS 

The Settings menu includes Color & Visibility Settings, Settings, Edit Expert 
Settings, Select Constituent Materials, and Edit Material Data Base. 

 

COLOR & VISIBILITY SETTINGS 

The default color settings applied to the 

background and materials during the 
generation with GeoDict, can be changed 

through the Color & Visibility Settings 
dialog, that opens from the GUI Sidebar on 
the right of the Visualization Area.  

 

 

If a structure is currently in memory, only 
the Material IDs present in the structure are 
editable in the Color & Visibility settings. 

Otherwise all 256 Material IDs are displayed.  

First, decide whether the chosen settings 

should be applied directly to the structure in 
memory by checking Apply Immediately. 
Otherwise, the Apply button must be 

pressed. 
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A color preset is a particular group of colors that are applied together. Click Load 

Preset and, in the Load Color Preset dialog, select whether to display the generated 
structure’s materials using one of the presets. 

 

Change all allows to change the color of all material IDs to the same color. By 
checking visible all material IDs can be set to be visible at once. 

Below, this can also be done for each material ID separately.  

Keeping a Color & Visibility Settings dialog open, instead of closing it, is helpful 
when trying to find the most adequate settings for a particular visualization.  

 

After selecting new colors through the buttons in the Color & Visibility Settings 

dialog, the current group of colors can be saved as a preset (Load Preset → Save 
as new Preset), to have it appear in the list of color presets later. 

More details about the GeoDict colors and visibility settings are found in the  
Visualization handbook. 

  

Gray values (adaptive) Default Reversed gray values (adaptive) 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2024
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SETTINGS 

Selecting Settings… from the Settings menu opens the Settings dialog to modify 
the general preferences or properties when working with GeoDict. The dialog contains 
the General, Parallelization, Statistics, and Job System tabs.  

They contain a collection of settings that a user typically wants to apply to any GeoDict 
session.  

 

Resting the mouse pointer over the icons in the lower left of settings dialogs prompts 
a tool tip showing the icon’s function to appear. For example, if the chosen settings 
should not apply only to this GeoDict session but instead should also be set at the 

next GeoDict startup, click the icon at the bottom of the dialog: 

 

After setting the current settings as start-up setting, click OK.  

The parameters entered in the Settings dialogs can also be saved into GPS (*.gps, 

GeoDict Project Settings) files and/or loaded from them.  

Clicking OK at the bottom of the dialog results in carrying out the modifications and 
closing the dialog. Select Cancel to discard the modifications entered in the dialog. 
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GENERAL 

The first option under the General tab controls the size of the fonts used in the GUI 
at start-up (GUI Start-Up Font Size). 

 

For example, increasing the GUI Start-Up Font Size to 14 results in the display of 

a larger font overall in the GUI after restarting GeoDict. 

GeoDict automatically stores a copy of the previous 3D structure, before applying any 

changes to it, until the Memory for Undo is filled up. This allows to quickly undo any 
changes using the undo function. 

 

The disadvantage of keeping a copy of the last structure is that some runtime and 

hard disk space is required for saving the structures. Thus, it can be disabled by 
setting the Memory for Undo to 0 MiB. 

If Check for GeoDict Updates is checked, GeoDict will automatically search if 
updates are available (requires internet connection) and print a message if an update 
is found.  

 

GeoDict will not automatically download or install those updates.  

In the corresponding panels underneath are the options for disk usage (I/O), for 

setting a default Text Editor, and the Timeout options can be specified. 
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I/O 

In the I/O (input/output) options, define how many days the log files should be kept. 
In the log files the events happening while running GeoDict are recorded. 

 

Also define whether the time a warning message is displayed should be limited, and 

the time of the limitation in seconds. If 0 is selected, pop-up messages are not shown 
at all.  

Text Editor 

The user can set which text editor is to be opened automatically when editing macros 

and other editable files. Click Browse to search and set the path to the location where 
the executable for the favorite text editor is located. 

 

For a list of text editor recommendations refer to the GeoPy Scripting handbook. 

Timeout options 

The last two options are for floating license users only. Define after how many hours 

the Floater Release Timeout will be triggered. Then all non-required floaters are 
freed and are available for other users. This is especially useful if long-running 

computations are performed. The same behavior occurs when pressing the Release 
Floaters button in the progress bar during a simulation run.  

 

The Idle Timeout triggers if after the defined hours no computation or user 

interaction was made. Then all floaters, including the GeoDict-Base floater, are freed 
and available for other users. It is possible to re-acquire the freed floaters when 

returning to the GeoDict application in the then opening dialog.  

PARALLELIZATION 

GeoDict Thread Parallelization 

The user can set the number of parallel processes (threads) GeoDict should use, e.g., 

for the visualization, for the image processing, and for the structure generation. It is 
possible to set the Thread Mode to Max. Thread Number which equals the Number 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Automation&release=2024
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of CPUs the machine has. When not all available CPUs of the computer should be 

used, for example to allow other users to work simultaneously on the same machine 
or to improve the performance of other programs, the number of used parallel 
processes can be limited by setting a Manual Thread Number. 

 

Choosing Automatic Thread Number uses the maximum number of cores, if up to 
eight cores are available. If more than 8 cores are available, the maximum of 8 and 

the number of available cores divided by two is used. For example, if the machine has 
12 cores available, automatic thread number takes the maximum of 8 and 12/2=6 
which is 8. 

This option does not influence the number of solver processes, which can be set for 
all GeoDict solvers in the Dict modules independently.  

Check Run GeoDict solvers with low priority to make the system more responsive 
when working interactively while a GeoDict solver (e.g. LIR or SimpleFFT) is running. 

Solver MPI Parallelization 

For cluster computations, set the environment variable that holds the location of the 

node file, i.e., the file that contains the list of assigned compute nodes. 

For MPI parallel computations, set the path to the MPI Installation that should be 
used for the parallelization. Select Automatic to look automatically for MPI 

installations. 

 

For more information, refer to the High Performance Computing handbook. 

STATISTICS 

The Statistics tab contains the Connected Components panel. A connected 

component is defined as a complete set of connected voxels with respect to the chosen 
neighborhood mode and component mode.  

Checking Show Number of Connected Components or Show Number of 
Connected Components in 2D Slice, and clicking OK, adds the number of 
Components to the Statistics section in the Status section (see page 46ff.) 

If the pore space is divided by the structure into several parts, it can be counted as 
one connected component with Count Pore Space as Single Component checked. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=HighPerformComp&release=2024
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The pore space does not count as an object and does not add to the number of 

Objects. 

 

As an example, a simple periodic structure model containing 10 spheres is shown. At 
the corners, it is the same grey sphere that disappears and reappears on the other 

side. Two red spheres are also cut in half. They disappear and reappear in Z-direction. 
Three of the red spheres overlap and one of the red spheres touches a grey sphere. 

The number of GAD Objects in 3D is 10, but the number of GAD Objects in 2D is 
only 4 (2 grey and 2 red spheres) in the 2D-Slice 126 in X-direction (shown below). 
The pore space is not counted as object. 
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Now, see how the connected components in 3D and 2D are counted when checking 

Show number of Connected Components and Show Number of Connected 
Components in 2D Slice.  

Neighborhood Mode and Component Mode define criteria for the connectivity of 

the components and are explained below. For this example, we choose Face as 
Neighborhood Mode, which means that two voxels are connected if they share a face. 

As Component Mode we choose Pore / Solid, so that solid voxels can form a 
component independent of their material ID. 

The number of Objects 3D and 2D are the same as before. Connected components in 

the 2D slice shown above are 4 (1 grey sphere + 1 red sphere + 1 [1 red sphere+1 
grey sphere] component + 1 pore space). 

Connected components in 3D are 8 (3 grey spheres + 3 red spheres + 1 [3 red 
spheres+1 grey sphere] component + pore space). 

 

The example structure shown is periodic, thus, objects that end on one side of the 
domain and reappear on the opposite side are counted as being the same connected 
component. Periodicity of the domain is saved in the structure file and can be edited 

through GadGeo → Edit Domain (see the GadGeo handbook for more information). 
This might change the number of components, e.g., if GAD objects lie outside of the 

domain if it is non-periodic. When changing to a periodic domain the objects are then 
placed inside the domain and coed for the number of components. 

Neighborhood Mode 

The Neighborhood Mode defines if two voxels are connected (and belong, 
depending on the component mode, to the same connected component) or not. The 

different modes are explained using this example.  

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GadGeo&release=2024&heading=EditDomain
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Two voxels can be connected through faces, edges, and corners. Voxels that share a 

face, do also share edges and corners, as you can observe for the red and the blue 
voxel. The blue and the green voxel share an edge and the corner points of this edge. 
Finally, the blue and the yellow voxel share only one corner point. This means, that 

voxels with common corners always belong to the same connected component. 

Thus, checking Face is more restrictive than choosing Face or Edge, and this is more 

limiting than selecting Face, Edge or Corner.  

When choosing the Neighborhood Mode Face only the red and the blue voxel are 
connected. When choosing Face or Edge the red and the blue voxel and the blue and 

the green voxel are connected. Finally, if Face, Edge or Corner is chosen the red 
and the blue voxel, the blue and the green voxel and the blue and the yellow voxel 

are connected. 

Component Mode 

For structures with more than one material, selecting Pore / Solid from the 
Component Mode pull-down menu determines whether the components are 

considered connected or not, based on being empty voxels (background) or solid 
voxels (structure), regardless of their material ID. When selecting Material ID, the 
Material ID (color) of the solid voxels (structure) is determinant for the components 

to be considered connected or disconnected.  

 

 

 

Periodicity: un-checked for all directions 

Neighborhood mode: Face 

5 connected components 2D = #1, #2 (half sphere top), #3 (2 spheres touching), 

#4 (half sphere bottom), and #5 pore. 

pore =5 

1 

2 

3 

4 
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Periodicity: un-checked for all directions 

Neighborhood mode: Face 

7 connected components 2D = #1 (grey sphere), #2 (half red sphere top), #3 (red 

sphere), #4 (grey sphere), #5 (1 blue overlapping voxel), #6 (half red sphere 

bottom), and #7 pore. 

pore =7 

1 

2 

3 

6 

5 

4 
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EDIT EXPERT SETTINGS… 

For many commands available in GeoDict’s modules, additional parameters exist that 
are not available through the dialog widgets that open in the corresponding modules. 
These parameters are also not stored in the parameter lists of those commands inside 

the python macros. By default, no expert settings are set, and well-chosen default 
values are used.  

Some expert settings allow to access experimental or unstable features. Others allow 
to access solver variants that are only useful in very special circumstances. In general, 
a user should not set any expert settings without consultation of Math2Market’s 

support.  

 

To activate an expert setting, after selecting Edit Expert Settings…, the user clicks 
Add Row to sequentially select the Module, the Command, and the Key that define 
the expert setting that should be edited. Afterwards, a Value for the chosen key is 

entered, typically True or False. 

Clicking OK at the bottom of the dialog results in carrying out the modifications and 

closing the dialog. Select Cancel to discard the modifications entered in the dialog. 
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The choices of module, command, and key are entered as columns into the first row. 

The user can now click the cell under Value and manually enter it. 
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SELECT CONSTITUENT MATERIALS 

A Constituent Material from the Material Database consists of a name for the raw 
material and the material’s physical properties and represents the properties of a 
material in a structure model. 

With a structure model in memory, showing in the Visualization area, select Settings 
→ Select Constituent Materials to change the raw material of a Material ID or 

assign a material to a Material ID with undefined material in a structure model.  

 

For example, in a foam structure the Material ID 01, initially defined as Aluminum, is 

changed to be made of Steel as follows: 
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After the new material is selected, close the Material Selector dialog by clicking OK 

and click Run in the Select Constituent Materials dialog. 

Observe in the Material Information legend how the constituent material of Material 
ID 01 has changed from Aluminum to Steel. 
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OPEN AND EDIT MATERIAL DATA BASE… 

In GeoDict, constituent materials (and their physical properties) are globally 
assigned to a structure and not just to a property predictor simulation. 

The GeoDict Material Database is a catalogue of the constituent materials that can be 

assigned to correctly identify digital materials in the structure models with properties 
of real materials.  

The user can access and edit the GeoDict Material Database from many modules or 
select Settings → Open & Edit Material Database… to directly access the 

catalogue from the menu bar. 

 

User-defined materials can be added to expand the GeoDict Material Database, or 

further properties can be listed for a material already included in the database. This 
is described in detail in the Material Database handbook. 

 

Each material in the database, together with its properties and description, is saved 
as a text-file with the name of the material. The user can edit these files in any text 
editor. The default GeoDict Material Database is located at: 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MaterialDatabase&release=2024
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RESET CURRENT SETTINGS TO BUILT-IN SETTINGS 

With Reset Current Settings to Built-In Settings the built-in settings for a specific 
GeoDict Edition can be reloaded. 

 

This is similar to the  button in the options tabs but affects the settings in all 

GeoDict commands. Furthermore, the built-in settings from another edition than the 

currently activated edition can be loaded. The current edition, with which the license 
is connected, can be found in the window title of the title bar. 
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MACRO 

The Macro menu contains the entries Start Macro Recording, End Macro 
Recording, Execute Macro / Script, and Session Macro.  

 

The entry End Macro Recording can be selected only during the recording of a macro 
to end the recording. 

Macro recording and execution and the options Convert GMC to Python Macro and 
Re-execute Last Python Script are explained in detail in the GeoPy Scripting 

handbook. 

GEOAPP 

When selecting GeoApp in the menu bar, a pull-down menu of GeoApps opens. The 

Shared GeoApps are groups of apps delivered with GeoDict and, later, apps that 
you and your colleagues create or modify to be shared with each other. Under My 

GeoApps find an example GeoApp provided by Math2Market. Use this section for 
local GeoApps, which should not be accessible by your colleagues, yet. Create your 

own GeoApps and place it in the GeoDict settings folder 
(%username%\GeoDict2024\MyGeoApps) to find it here.  

 

The individual GeoApps are sorted by their application fields or the module they 
belong to. Selecting a GeoApp from the list opens the GeoApp section, located left of 

the Visualization area. It contains a pull-down menu that lists the available Python 
scripts for the corresponding GeoApp. 

When selecting one of the available scripts, the description area displays a report 

about the script. In the script, this report content can be found inside the apostrophes 
after Description = ''' ''' and can be edited at any time after opening the script with 

a text editor.  

For the 3D-Image Report script from the Report and Image GeoApp, the text in 
the macro and the description area are shown below.  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Automation&release=2024
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Click the Options’ Edit … button to edit the parameters of the macro. To open the 

GeoApp in an editor, click Open Macro / Script File. Clicking Run executes the 
script. 

 

The GeoApp scripts listed in the pull-down menus can be found in the GeoDict 

installation folder in the subfolder GeoApp or in the subfolder of the corresponding 
module. 

More details about using GeoApps can be found in the GeoApps handbook. 

CLOUD & QUEUE 

The Cloud & Queue menu allows to manage simulation jobs in the GeoDict Cloud 
and on Job Queue Servers. 

 

Clicking on GeoDict Cloud Projects… opens the Login dialog to the GeoDict 
Cloud Service. After login in, an overview of all cloud projects is opened. Log out 

from the Cloud by clicking on Logout from GeoDict Cloud. 

More information on the GeoDict Cloud can be found in the High Performance 
Computing handbook. 

A list of projects in the job queue system can be obtained by clicking on Job Queue 
Projects…. Clicking Start Job Queue Server opens a terminal window in which the 

job queue server runs.  

More information on the Job Queue can be found in the High Performance Computing 

handbook. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GeoApp&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=HighPerformComp&release=2024&heading=GeoDictCloud
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=HighPerformComp&release=2024&heading=GeoDictCloud
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=HighPerformComp&release=2024&heading=ExecuteInJobQueue
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HELP 

The Help menu links directly to several handbooks of the User Guide on the GeoDict 
web page. Direct links are provided for information on installation and licensing of 

GeoDict, the introduction to the GUI, menu and toolbar, the Result Viewer for the 
result files, visualization and video creation in GeoDict, using GeoDexcel and GeoLab, 
and setting up high performance computing. 

 

All User Guide handbooks can be downloaded as a block in zipped .pdf format. 

Clicking About GeoDict opens a window giving information on GeoDict version, 
revision number, and licensing.  

We also acknowledge the third-party components used in GeoDict. 
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HARDWARE STATUS, PROJECT STATUS, AND MODULE SECTION 

The Status and Modules section is divided into the hardware status section, the 

project status Section, and the module section. It can be collapsed by clicking on 

the  icon or expanded in a new window by clicking on the  icon. 

 

HARDWARE STATUS SECTION 

At the top of the status and modules section, the hardware status is shown. The icons 
are described in order of their appearance from left to right. First, the current CPU 

load is displayed. The second icon shows the currently used RAM. Both refer to all 
processes running on the computer, not only to GeoDict. Finally, the percentage of 
Disk Space occupied on the hard drive where the project folder is located is given.  

 

PROJECT STATUS SECTION 

In the Project Status section several information about the current project and the 
loaded files is shown. Sections can be expanded by clicking on the small triangle on 

the left or double clicking on it. Most of the sections offer an additional menu when 
performing a right-click on it. Often, these are shortcuts to commands that are 
available in the menu bar or are part of the GeoDict Base module. 
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CURRENT PROJECT FOLDER 

First, the path of the Current Project Folder is given. Expanding the section lists all 
GeoDict Result files (*.gdr) which are stored in the project folder. Double clicking on 
a file name opens it directly in the Result Viewer. 

 

A right-click on the Current Project Folder row opens a menu used as shortcut for 

Choose Project Folder (see page 8 for details). 

STRUCTURE 

The color dot in front of Structure shows whether any voxelized structure is loaded 
into GeoDict (green dot), or not (red dot). 

The Structure model is identified by File Name, Description, Voxel Count, Voxel 

Length, Domain Size and the internally hashed Structure ID number. A structure 
generated, e.g., with FiberGeo, GrainGeo, PaperGeo, WeaveGeo, GridGeo, or 

PleatGeo, with the same parameters and the same random seed, has always the same 
Structure ID number. The Structure ID number changes as soon as the structure 
is modified in any way.  

 

Right-clicking on the Structure row opens a menu used as a shortcut to apply 

modifications to the microstructure. 
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Most of the commands in this menu are shortcuts to several functions included under 

the File menu in the menu bar (see page 4ff.), in the ProcessGeo module (Model → 

ProcessGeo, see also the ProcessGeo handbook), or in the LayerGeo module (Model 
→ LayerGeo. See also the LayerGeo handbook). 

By right-clicking on Description the description of the structure can be changed. 

The Adjust Voxel Length command can be accessed by right-clicking on Voxel 
Length, where the current voxel length is shown in the selected units (m, mm, µm, 

nm, Inch). 

 

GAD OBJECTS 

The color dot in front of GAD Objects shows whether analytical information about 
the objects inside of the current structure is available (green dot), or not (red dot). 

The dot is yellow when information about objects inside of the current structure is 
available, but this information does not describe the current voxelized structure 

completely. This may happen, for example, when the structure has been modified 
after the generation (e.g., with ProcessGeo or LayerGeo). 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ProcessGeo&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=LayerGeo&release=2024
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Also shown is the number of GAD objects (such as fibers, grains, etc.) in the structure 

(GAD Object Number). 

Right-clicking on GAD Objects opens a list of possible modifications, like editing the 
GAD objects or the domain, creating, adding, deleting, scaling, shifting and rotating 

GAD objects, resolve overlap and mark contacts, change the Material ID model, or to 
create a GAD index image or an orientation image. All of these modifications can be 

accessed also from the module GadGeo and are explained in the GadGeo handbook.  

By choosing Algorithms, all manipulations of analytic objects, available in the section 
Algorithms of GadGeo can be accessed. 

STATISTICS 

The 2D statistics are only shown if the 2D Cross Section is activated. Then, the 

number of GAD Objects contained in the currently selected 2D slice is shown. The 
values vary when choosing (in the Camera tab) another cutting plane from the 
Direction pull-down menu and/or moving the Slice slider. Next, the volume 

percentage of all Material IDs present in the structure are listed. Unfold the Material 
IDs by clicking on the small black triangle. When hovering above an entry with the 

mouse the number of voxels of this material ID is shown in the tooltip. Unfolding 
Materials shows the volume fraction of each material in the structure. The materials 

are classified as Pore and Solid. Again, hovering above an entry shows the number of 
voxels of this material in the current 2D slice.  

If the option Show Number of Connected Components in 2D Slice has previously 

been activated through the Settings → Settings… dialog in the Statistics tab (see 

page 29ff.) Components is the number of connected components contained in the 
currently shown 2D slice.  

 

The 3D statistics are shown in both the 2D cross section view and 3D rendering. The 

information shown is the same as for the 2D statistics, but the values refer to the 
entire 3D image. 

The number of Components is the number of connected components contained in 
the entire image. This value is only shown if the option Show Number of Connected 
Components has previously been activated through Settings → Settings… dialog 

in the Statistics tab. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GadGeo&release=2024
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SURFACE TRIANGULATION 

If a triangulation is loaded into the GeoDict Memory, the Surface Triangulation 

section is displayed.  

 

When unfolding it, the number of triangles, edges, and vertices is shown. For the 

triangles and edges, the average, minimum, and maximum values are given. For the 
vertices, the minimal and maximal coordinate in all directions can be observed.  

A right-click on Surface Triangulation opens a context menu which gives access to 
many functions from the MeshGeo module. The commands are all described in the 
MeshGeo handbook. 

 

 

https://geodict.com/fileadmin/script/UserGuide.php?lahttps://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MeshGeo&release=2024
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CONSTITUENT MATERIALS 

The next entry in the project status section is Constituent Materials. This block lists 
the materials that are present in the structure and are shown in the Material 
Information legend next to the microstructure in the Visualization area. 

Right-clicking on Constituent Materials gives access to the Select Constituent 
Materials dialog (see page 36) and is a shortcut to selecting Settings → Select 

Constituent Materials in the menu bar. Open & Edit Material Database is a 
shortcut to Settings → Open & Edit Material Database (see page 38).  

 

The current temperature can be edited in the constituent materials dialog and also by 
clicking on Change Temperature… , which opens a separate dialog.  

 

Choose the temperature unit from the drop-down menu on the right. Available are 
Kelvin, °Celsius, and °Fahrenheit. Then enter the value, which must be in the 

temperature range given by the numbers on the left and the right. 

It is also possible to Set all Fluids to… one chosen material. This option changes the 

material of all material IDs with a material of type fluid or pore. With Set all Solids 
to…, the same can be done for all solid materials.  
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The user can also Set Material Information for any material ID. Type the 

information in text form in the Set Material Information box and click Run. The 
information is then displayed in squared brackets in the material legend in the 
visualization area. 

 

In the example shown above, two Constituent Materials are listed in the Project 

Status section (Air and Manual), corresponding to Air and Solid in the Material 
Information legend. The fibers with material ID 01 and material ID 02 are set to be 

made of the same constituent material. 

 

After selecting the constituent material and changing the material of material ID 01 
to Aluminum and material ID 02 to Nickel, the number of Constituent Materials in 

the Project Status section changes from (2) to (3). The Material Information of 
Aluminum was additionally set to Fiber Type 1. 

A right-click on a single material offers the following options. With Edit Material in 

DB… the entry in the material database of the corresponding material is opened. The 
Material Database handbook explains how a material can be edited.  

 

By clicking on Get Material Data… a dialog is opened where a result file name and 

a material can be entered. Clicking on Run produces a GeoDict result file which 
contains all information from the material database of the chosen material as key-
value map.  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MaterialDatabase&release=2024
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With Reassign Material… the chosen material can be reassigned to another material 
(See the ProcessGeo handbook for more information). 

OPEN RESULT FILES 

Open Result Files shows the number and names of result files (after expanding the 
list) that are currently opened in the Result Viewer. Double-clicking on the file name 

raises the result viewer. With a right-click on Open Result Files the option to Close 
all GDR-Files appears.  

 

A right-click on a gdr file name opens a context menu, which offers shortcuts to 
functionalities that are available in the result viewer. The Result Viewer handbook 

provides more information on these commands. 

VOLUME FILES 

The last entry in the Project Status section is Volume Files. After loading a volume 
file (e.g., after an effective stiffness simulation with ElastoDict-FeelMath-VOX), the 
number of the loaded Volume Files appears in the Project Status section.  

Each of the volume files consists of volume images and they contain volume fields. In 
the example shown here, the volume file StrainStressResult_xy.das is loaded. It has 

the volume images vonMisesStrain and vonMisesStress, and they contain a volume 
field with the same name, respectively. The volume filed vonMisesStress is greyed 
out, because it was not selected in the loading volume file dialog (see page 6)  

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ProcessGeo&release=2024&heading=ReassignMaterial
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ResultViewer&release=2024
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With a right click on the name of the volume field, the Load option is available. 

Alternatively, double clicking on a volume field loads it into GeoDict and it can be seen 
in the Visualization area.  

 

Right-clicking on Volume Files opens a list of options.  

 

Discard Volume Files and Load Volume File are the same as those from the File 
menu in the menu bar (see page 4ff.). It is also possible to Create New Volume 

Files or to Create a Gaussian Random Field. 

In the Create New Volume File dialog, enter a Filename und define the Type of 
the volume file. The user can choose a preset of GeoDict volume file structures or 

choose empty. In the latter case, the created volume file does not contain any image 
or field. Instead, the user can fill the file with Create New Image and New Field, 

which are described below.  

If a predefined volume file was chosen, the volume file contains the standard images 

and fields. For example, the preset vap produces a volume file that contains a 
Velocity image with the fields VelocityX, VelocityY, VelocityZ, and Velocity and 
a Pressure image with the Pressure field. All the fields contain zero values and can 

be filled afterwards using, e.g., the Math Operations (see page 54ff.) or via Python 
scripting with GeoPy (find more information in the GeoPy Scripting handbook). A 

description on how to Create a Gaussian Random Field can be found here in the 
GrainGeo handbook. 

A right click on a loaded volume file name provides further options.  

 

Choose Properties to get information on the volume file loaded.  

This volume file can also be saved to the hard disk as Current File Type, Universal 
GeoDict File (*.guf), or as GeoDict Raw Data (*.grw).  

With Create New Image two types of images can be created. If Scalar is chosen, 

an empty volume image is created and a new volume field can be created as shown 
below. If Vector is chosen, the unit for the vector field must be entered (e.g. m/s for 

a velocity field).Then, a volume image with 3 volume fields (containing only zeros) is 
generated and also the norm is automatically computed and shown. The created 

volume fields are the component fields for the X-, Y-, and Z-direction. With Copy… 
the entire volume file including all images, fields, and values is copied, after entering 
a name for the new volume file. The new file is only stored in GeoDict. To save it to 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Automation&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GrainGeo&release=2024&heading=GenerateGaussianRandomField
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the hard disk, click on Save Volume File. Click on Remove to delete the volume file 

including all its images and fields from the GeoDict memory. 

Right-clicking on a volume image opens further options. 

 

Choose Properties to get information on the volume image and to change its name. 

The function Interpolate to Voxel Center interpolates the data to the voxel centers 
using the values on edges and faces of the voxels. It is only available for vector 

images and not for scalar images.  

The user can also create and add a New Field to a volume image. In the opening 
dialog, enter a Fieldname and the desired Unit of the volume field. Select the Data 

Type and the Fill Method from the corresponding drop-down menu. The fill method 
determines if the values in the new field are zeros, ones, randomly distributed 

(between 0 and 1) or gaussian randomly distributed around zero.  

With Remove a volume image can be deleted from the GeoDict memory. It is not 

deleted from the volume file saved in the project folder. 

Some of the options are not available if a compressed volume file is loaded without 
decompressing it during the import. Instead, the option to Decompress the file when 

it is already in the GeoDict memory is available. 

Finally, a right click on a volume field provides other possibilities.  

 

With Properties the Name and Unit of a volume field can be edited.  

The commands Compute Metrics and Threshold to Structure are explained in the 
sub-sections below.  

The selected volume field can be Saved as *.guf file or in another file format as 
described on page 16.  

It is possible to Move or Copy the volume field to another volume image of the same 
size, and to Remove it from the GeoDict memory.  

The Math Operations on a volume field are described below on page 54.  
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Compute Metrics 

With Compute Metrics, access statistical properties of the volume field. 

 

Enter a Result File Name (*.gdr) to save the results in. Then, select on which of 

the loaded Volume Fields the properties should be computed. 

The Random Seed influences the results of Autocorrelation and Correlation Length. 

Below, choose which metrics should be computed. 

 

Minimum, Maximum and Mean Values, Standard Deviation and Variance can 

be computed for either Pore, Solid, All Materials, Chosen Materials or Chosen Material 
IDs. 

Minimal, Maximal and Mean Values can also be determined slice-wise for a 

chosen direction and Pore, Solid, All Materials, Chosen Materials or Chosen Material 
IDs. 

When Autocorrelation is selected, the similarity of voxels in a given distance 
between Minimal Length Scale and Maximal Length Scale is measured. This is 
similar to the MatDict command 2-Point Correlation and details on the selectable 

options are described in the MatDict handbook. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MatDict&release=2024&heading=TwoPointCorrelation
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The Correlation Length is a measure on which length scale the values of the volume 

field change. 

With Spatial Intensity Histogram a histogram of the values in the volume field is 
computed with respect to the entered Number of Bins. 

Clicking Run computes the chosen metrics. After the run is finished, the result viewer 
opens and shows the results in the report tab. Additional plots are available in the 

Plots subtab for Slice Minimal, Maximal and Mean Value, Autocorrelation, or 
Spatial Intensity Histogram selected. 

Threshold to Structure 

Select Threshold to Structure to create a structure with voxels above or below a 

defined threshold of a volume field. One or two thresholds can be defined. 

If 3D rendering was chosen before check Preview Threshold in 3D to visualize the 
created structure already before clicking Run. This is only available for one threshold. 

Define e.g. 2 thresholds to create a structure with voxels of ID 01 where the von 
Mises Strain of the fibrous structure is above 1e-06, and with voxels of ID2 at 

locations with von Mises Strain above 4e-06. 

 

 

Math Operation 

Choose Math Operation to open a dialog that allows to manipulate the volume field 
in different ways. Each math operation generates a new volume image containing the 
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modified volume field. The single volume fields can be saved in *.guf format or the 

complete modified volume file can be saved, after the unwanted volume images were 
removed. 

◼ Normalize Field: Define a new minimum and maximum value and normalize 

the values of the volume field accordingly. 

 

◼ Subtract Field: Choose another volume field, e.g., from another result file, that 

will be subtracted from the current volume field. Note that the volume fields 
must be of equal size. 

 

◼ Add Field: Choose another volume field of the same size that will be added to 
the current one. 

 

◼ Compute Gradient: No further parameters are needed to compute the gradient 

for the current volume field. This results in a vector image with the three 
component vector fields. 
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◼ Convert to Data Type: Choose a new data type (single, uInt32, uInt16 or 

uInt8) and convert all values of the current volume field to this type. The current 
data type is greyed-out and cannot be selected. 

 

◼ Add (Subtract) Constant Value: Add a constant value to the volume field. 

Enter a negative value to subtract it from the volume field. 

 

◼ Multiply Constant Value: Multiply each entry in the volume field by a constant 
factor. 
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The math operation Convert to Data Type with the type uInt8 or uInt16 chosen 

offers further possibilities in the right-click context menu for the converted volume 
field.  

 

The volume field can be Opened in the Image Processing Dialog (see the 
ImportGeo-Vol handbook). The user may choose to Create a Triangulation (more 

details can be found in the MeshGeo handbook), Save as 2D Image Stack, or Save 
as 3D Image. 

Use the math operation Convert to Data Type to save a volume field as RAW-file. 
For example, the field “vonMisesStrain” is saved in the following way: 

1. First, convert the data in the field to the right data type. Right-click on the 
vonMisesStrain field and choose Math Operation….  

 

2. In the dialog select Convert to Data Type from the first pull-down menu and 
Unsigned Integer 8-Bit from the second. Then click Run.  

 

3. A new Volume Image appears under the currently loaded Volume File: Math 
Operation 1. There, the new Volume Field vonMisesStrain Converted to uInt8 

is shown. Right-click on it and choose Save.  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ImportGeoVol&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MeshGeo&release=2024&heading=CreateVoxelMesh
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4. Select a name and choose Integer Data - Binary (*.raw) as file type. Then, the 
volume field is saved in the current project folder, or another folder may be 
chosen. 

 

PARTICLES 

If Particles are loaded into the GeoDict memory, the number of particles is shown in 
the status section. With a right-click, the option to Discard Particles is available. 

This is the same as the Discard Particles option from the File menu (see page 17). 
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MODULE SECTION 

The heading of the Module section changes to the GeoDict module selected from the 
menu bar. The GeoDict modules are organized into modules to Import and pre-

process files and 3D image data, generator and structure-modifying modules to 
Model microstructures, structure analyzing modules to Analyze, properties predictor 
modules to Predict, and modules to Export files to other formats.  

 

The module section contains a pull-down menu, from which you can choose a 
command to execute. Depending on the chosen command, there is either a Browse... 

button for choosing files or an Edit… button, where the options necessary for 
GeoDict’s generators, modifiers, or solvers, can be edited. The Help button directly 
links to the handbook where the chosen command is explained in the handbook of 

the corresponding module. The Help button is also available in the options dialogs 
that open when clicking on Edit. 

Depending on the module, the button Generate, Run, or Export starts the actions 
of the generator, the solver or the export. For ProcessGeo, LayerGeo, and BatteryDict 
the button specifies the particular modifying process (Reassign, Rescale, Compress, 

Attach, Erode, Dilate, Design, Analyze, Charge etc.). 

The module section includes a Record button (except for the Import modules), which 

is selectable when Macro → Start Macro Recording... is selected in the menu bar. 

Clicking Record records the settings and actions of the module without obtaining the 
results (yet), while Run & Record, which appears instead of Run after starting macro 

recording, starts the computation and additionally records the action in the macro 
file. 
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For some modules, the module section includes an Estimate Memory or Estimate 

Memory & Disk-Space button, that becomes active for the functionalities that 
support such an estimation. It allows you to estimate the memory (and disk-space) 
required for the computation before starting the computation. 

The button Cloud allows to perform the calculations in the GeoDict Cloud and with 
Job Queue the simulation run can be executed on a job queue server. More 

information on how to start a calculation in the cloud or the job queue can be found 
in the High Performance handbook.  

The use of the modules is explained in the handbook for each module. See page 19ff. 

for links to the individual handbooks).

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=HighPerformComp&release=2024&heading=dst_GeoDictCloud
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VISUALIZATION AREA AND VIEW CONTROL PANEL 

When you load image data into GeoDict it is shown in the Visualization Area. The 

image might be of a fibrous-, paper-, granular-, sintered-, pleated-, woven-, or grid-
structure created with one of GeoDict’s structure generators, an image from an 

opened *.gdt file, an image imported and segmented with ImportGeo-Vol or 
ImportGeo-CAD from a stack of 3D image data (µCT, FIB/SEM), or other structure 
models. Result Data from GeoDict’s predictor modules, such as velocity fields and 

particle trajectory files, can also be loaded as image data. Above the visualization 
area, the View Controls panel is one of the access points to change the visualization 

of the image. 

Other access points are the View menu (see page 22) and the Color & Visibility 
Settings in the Settings menu (see page 24).  

The View Control panel looks different for the 2D Cross Section (SEM) view and the 
3D Rendering mode. For the 2D View and the 3D rendering the tabs Camera, 

Structure, Volume Field, and Arrows are available. The volume field and arrows 
tabs are greyed-out if no corresponding data is loaded. Some data from volume files 
can only be visualized in 3D rendering mode. Thus, in 3D rendering the additional 

tabs Streamlines, Particles, Triangles, Schlieren, and Tensors appear. 

To start the visualization of results, a result file must be loaded through File → Load 

Volume Field … or Load Particles … in the menu bar, or directly by loading from 

the Visualization tab of the GeoDict Result Viewer.  

 

Expand the View Controls panel to a new window using the  button and collapse it 

with  to have more space for the visualization area. 
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More detailed information about visualization in GeoDict can be found in the 

Visualization handbook. 

 

WHAT ARE VOXELIZED AND ANALYTIC STRUCTURE MODELS? 

Structure models in GeoDict can be described in two different ways: 

⚫ Analytic representation: The structure is described analytically (e.g. multiple 
spheres with given diameters and positions). The structure information is stored 
as GAD-objects (GAD = GeoDict Analytic Data). 

⚫ Voxel representation: The structure is described by its voxel grid.  

Editing and modification of structure models can be done on the structure’s voxel 

geometry description or analytic description.  

Simple and complicated microstructures can be edited by manual drawing, e.g., to 
correct problematic boundary effects. Among other applications, voxel and analytic 

data editing can be used to remove artifacts from 3D structures built from imported 
3D-image data (micro-CT, nano-CT, SEM, …).  

For structure models created using GeoDict’s generator modules, undesired 
fragments of the structure can be easily modified or eliminated, without having to 

reset the parameters and generate again.  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2024
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This direct editing or modification of voxelized structure models is a complement to 

the GadGeo module. GadGeo generates and edits on the analytic level on structures 
with available analytic information, whereas editing is also applicable to structure 
models with voxelized formats.  

Structure models can be manually edited with GeoDict, using the following icons in 
the toolbar: 

Clicking on an icon changes the functionality of the cursor and opens the 
corresponding menu from the sidebar. Part of the functionality for structure editing 

can be accessed also by a right mouse click in the visualization area, see page 64. 

Here, as a simple structure example, a fibrous media model is generated with 

FiberGeo. Additional to the voxel representation, analytic data is available for the 
structure, which consists of 177 GAD objects. The structure model contains curved 
fibers of two different raw materials, initially set as Manual (Solid).  

Below examples to edit and modify this fibrous media model structure in both 
representations follow. After editing, the structure must be saved to preserve all 

modifications. 

  

2D / 3D 
 

Select voxels (see page 69) 

2D / 3D 
 

Select analytic (GAD) objects (see page 74) 

2D 
 

Edit in a way similar to the Windows standard editor Paint (see 
page 77). 
Observe results in 3D (edited objects can be three-dimensional) 
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SHORTCUT TO SELECTION AND EDITING FOR VOXEL AND ANALYTIC DATA 

Right click with the mouse in the visualization area to get access to shortcuts to select 
voxels and / or GAD objects, apply algorithms to the selection, edit the selected voxels 

or objects, and control the mouse functionality. 

Part of the selection and editing functionalities are also available from the GUI sidebar 
and their explanation starts on page 68. The voxel or the GAD object, on which the 

right-click was made, can be selected and is added to the Voxel Selection sidebar 
or the GAD Object Selection sidebar. Previously selected GAD objects can be 

removed from the selection list with Deselect GAD Object, or the selections of both 
dialogs can be removed completely (Clear Selection). 

 

After a selection has been made, different modifications can be applied to the selection 

(Apply to Selection).  

 

It is not necessary to click again on a selected voxel or GAD object. Choose Reassign 
Selected GAD Objects to assign a new material ID to the selected objects. 
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With Edit Selected GAD Objects, all objects listed in the GAD Object Selection 

dialog can be modified at once. Have a look into the GadGeo handbook for a 
description of this command.  

Voxels listed in the Voxel Selection dialog or the whole components connected to 

them, can be reassigned to a new Material ID with Reassign Selected Voxels or 
Flood Fill Selected Voxel Components. In the opening dialog, choose the new 

Material ID for the operation. You can also add a material information which is 
displayed in the material legend. For example, you can reassign a voxel to a not 
already present material ID and set the material information to a specific property of 

this voxel. 

 

The options in the Edit section apply modifications to the structure without the need 

to make any selection of voxels or GAD objects. With Edit GAD Object the GAD 
object on which the right click was made can be modified in the same way as it can 

be done for selected GAD objects.  

 

Under Domain, Edit the current Domain (see the GadGeo handbook) or use Crop 
and Embed from ProcessGeo.  

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GadGeo&release=2024&heading=GadEdit
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GadGeo&release=2024&heading=EditDomain
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ProcessGeo&release=2024&heading=Crop
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ProcessGeo&release=2024&heading=Embed
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With Reassign, Material IDs and Materials can be reassigned as it is described in the 

ProcessGeo handbook.  

 

When choosing Reassign Material ID, Reassign Material or Reassign Material 
of Material ID, the Material ID or Material at the voxel where the right click was 
made is set as old Material ID or Material. With Reassign Voxel at the voxel at this 

point can be reassigned to another Material ID. Flood-Fill Component at is similar 
to Flood-Fill Component for a selection of voxels (see page 70), but here for the 

current voxel. Finally, with Reassign GAD Object the GAD Object at this position 
can be reassigned to a new Material ID. 

Select the options available under Controls, to Reset View settings according to the 

startup-settings (also available in the Camera tab in the view control panel), to switch 
between the icons of the toolbar for the mouse functionalities (Navigate, Edit Voxels 

and Edit GAD Objects), and to change the settings for the Tooltip shown for the 
structure. 

 

Choose which information should be shown for the position of the mouse pointer in 

the structure. For the position of a voxel, the coordinates can be shown in number of 
voxels in each direction (Show Voxel Coordinates) or as coordinates in length units 
with respect to the origin of the structure (Show World Coordinates).  

Check Show Voxel Material to add the Material and Material ID information to the 
tooltip. Check Show GAD Information, to show the object type and Object ID of 

the GAD object the voxel belongs to (only shown if analytic object data is available 
for the structure).  

Select Show Volume Field Information (Visible Only) or Show Volume Field 

information (All) to show the value of the currently selected volume field, or of all 
volume fields available, at the current position, if a volume field is loaded for the 

structure. 

 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ProcessGeo&release=2024&heading=Reassign
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Use Uncheck All to deselect all boxes of the Tooltip options, or Reset to Default 
Settings to reload the GeoDict default settings for the tooltips. 

 

Check Infinite Tooltip Duration to prevent the tooltip from vanishing after a few 
seconds.
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GUI SIDEBAR 

Many functionalities for Visualization, Color & Visibility, editing and modifying on 

the voxel structure (Voxel Selection) or the analytic data (GAD Object Selection),  
modifying the material ID of selected voxels (Paint), measuring distances and angles 

(Metrology) and saving the recently executed commands (Session Macro) are 
opened directly from the GUI sidebar. 

 

Some tabs of the sidebar are hidden if GeoDict is not in full screen mode. Expand and 
collapse the sidebar by clicking on the  icon at the bottom. Each dialog can also 

be expanded and collapsed by clicking on the  icon at the top of the tab.  

When expanded, the sidebar panel can be un-docked by clicking the  icon at the 
top of the open panel and turned into a dialog that can be moved around. 

 

Information about the Visualization tab and the Color & Visibility tab from the GUI 
sidebar are described in detail in the Visualization handbook.  

The Session Macro tab is explained in the GeoPy Scripting handbook. 

The functionality of the tabs Voxel Selection, GAD Object Selection, Paint and 
Metrology is explained below. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Visualization&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Automation&release=2024
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VOXEL SELECTION 

A voxel structure of a fibrous media model generated with FiberGeo is loaded 
(indicated by the green dot before Structure) and also analytical data fitting to the 

voxel data is available (indicated by the green dot before GAD Objects). 

 

We now want to edit the structure by editing the voxels. The analytic object 

information will not be modified, and therefore the analytic object description in the 
model does not fit anymore to the loaded structure after editing. The initially green 

dot before GAD Objects turns yellow, if one of the operations listed below is applied. 

The voxels forming a fiber in the structure model are edited in 2D Cross Section (SEM) 
view or in 3D Rendering, as follows: 

1. Select voxels:  

a. Zoom into the structure by pressing and holding the right mouse button while 
moving the mouse back and forth or scroll the mouse wheel. 

b. To enter the Voxel Selection mouse mode, click the  icon in the toolbar. 

This also opens the Voxel Selection dialog from the GUI sidebar.  
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c. Click on a voxel to select it. For several voxels, press and hold the Shift key on 

the keyboard while clicking the voxels. A cyan-colored frame appears at the 
edges of the selected voxel(s). At the same time, the parameters defining the 
voxel(s) (Position as X, Y, Z coordinates and Material ID) appear in a table in 

the Voxel Selection dialog. 

 

d. If a voxel is mistakenly selected, hold Ctrl and click again on that voxel.  

e. Clicking Clear Selection in the Voxel Selection dialog removes all voxels from 
the selection. 

2. Edit voxels by selecting one of the Component Mode commands and clicking 
Run: 

a. Flood-Fill Component: Fill the selected voxels and the components connected 
to them (see page 29) with a New Material ID chosen from the pull-down 
menu.  
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b. Flood-Fill Component Plane: Fill the selected voxels and the components 

connected to them with a New Material ID only in the Plane chosen from the 
pull-down menu.  

c. Reassign Material of Objects (*.g32): If a *.g32 file with object indices is 

loaded in the GeoDict GUI (e.g., created by right clicking on GAD Objects in the 
Project Status Section and selecting Create GAD Index Image, see page 46), 

the Object ID is additionally shown for each voxel selected. Select a New 
Material ID and click Run, to assign the new material to all voxels that belong 
to the same Object ID as the voxels selected (here Object IDs 76, 104 and 

163). 
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d. Reassign Material of Selected Voxels: The material ID of the selected voxels 

can be changed by selecting a New Material ID from the pull-down menu. 

e. Dilate Selected Voxels: It is possible to dilate the voxels by coating them 
with another material chosen from the Coating Material ID pull-down menu 

by a certain number of voxels (Dilate by). An explanation for the dilate 
command can be found in the ProcessGeo handbook. 

 

f. Dilate Component: Also possible is to dilate the selected voxels and the 
components connected to them with the Coating Material ID by a certain 

number of voxels (Dilate by). 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ProcessGeo&release=2024&heading=Dilate
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g. Dilate Component Plane: Dilate the selected voxels and the components 

connected to them only in the Plane chosen from the pull-down menu with the 
Coating Material ID by a certain number of voxels (Dilate by). 

All these operations can be undone by clicking the  icon in the toolbar or CTRL+Z. 

3. Select exactly two voxels to create a Line Plot for Geometry & Fields. This will 
gather information on the structure along the straight line between the two 

selected points. After entering a Result File Name, click on Create Plot. Then, 
the Result Viewer opens and shows in the Report tab the start and end point of 
the line in X-, Y- and Z-coordinates as well as the length of the line. For each 

loaded volume field the minimal, maximal and mean value on the line is stated. 
In the Plots tab, the Material IDs along the line are plotted over the distance from 

the starting point in the Voxel Geometry subtab. Each volume field has its own 
subtab with a plot of the field values on the line over the distance. 
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GAD OBJECT SELECTION 

The same fibrous media model as in the section above is edited, but now the analytic 
objects are modified. This is possible if a structure in GAD format is loaded, or a 

structure in GDT file format with analytic object information contained in the GDT file. 
The information that appears in both cases in the project status section, is 
equivalent.  

 

In contrast to editing the voxel structure, editing the analytic objects preserves the 
analytic object information in the file. 

The analytic objects (fibers) in this fibrous structure model can be edited, while 

visualizing the material model in 2D Cross Section (SEM) view or in 3D Rendering, as 
follows: 

 

1. Select analytic objects:  

a. To enter the GAD Object Selection mouse mode, click the  icon in the 

toolbar. This also opens the GAD Object Selection dialog from the GUI 

sidebar.  

b. Click on a GAD object to select it. For several objects, press and hold the Shift 

key on the keyboard while clicking the objects. The selected object(s) appear(s) 
highlighted. 

c. The table in the GAD Object Selection dialog shows the ID number and the 

Object Type of the selected GAD object. 
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d. If an object is mistakenly selected, press and hold the CTRL key and click on 

the object again. 

f. Clicking Clear Selection in the GAD Object Selection dialog removes all 
objects from the selection. 

2. Edit analytic objects: 

a. When clicking Delete Objects, all selected fibers, which are listed in the table, 
are deleted and taken out from the structure model. 

b. Change Material ID: The material ID of the selected objects can be changed 

by selecting a new material ID from the pull-down menu and clicking Change 
Material ID. 

 

The selected fiber(s) still appear(s) highlighted (and perhaps makes it difficult to see 

the change in the material) until the user clicks Clear Selection. 

Now the fibrous structure model contains fibers of three different materials. 
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It is also possible to Edit Objects in a dialog which looks similar to the GadGeo Edit 

GAD Objects dialog, but it contains only the chosen GAD Objects. With a double click 
or right click on one of the selected objects in the table the Edit menu for only this 
object can be opened. The GadGeo handbook describes how the GAD Objects can be 

edited.

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GadGeo&release=2024&heading=GadEdit
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PAINT 

The Paint Mode editing works in a way similar to the Windows standard editor Paint. 

Editing is always done in 2D (View → 2D Cross-Section (SEM)) and the effects can be 

seen later in 2D as well as in 3D (View → 3D Rendering). 

The Paint Mode places GAD Objects with the shape chosen in Brush Mode into the 

structure. After painting, these GAD objects can be modified, e.g. as shown before on 
page 74. Thus, using the paint mode on a structure with analytic object information 
changes the analytic data. After editing in the paint mode, the changed structure 

must be saved to store the modifications. 

As an example, a fibrous media model is edited with Paint Mode.  

 

The Paint mode is used as follows: 

1. Select View → 2D Cross-Section (SEM) in the menu bar or click the  icon in 

the toolbar.  

In the Visualization panel, above the Visualization area, click the Camera (Y, Z) 
tab and use the Direction pull-down menu and the Slice slider to navigate to the 

location where the editing should take place. Here, direction Z and slice 90 is 
selected. 
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2. Click the Paint tab on the GUI sidebar to open the Paint Settings dialog. The 

Paint mouse mode is activated with the  icon from the toolbar, which also opens 

the paint settings dialog. The Paint tab is greyed out and not accessible when the 
structure is viewed in 3D rendering. 

3. In the opening Paint Settings dialog, editing is done using the cursor as a brush. 

Make sure, that the  icon is selected, so that the brush is active! The shape of 

the brush is set in the Brush Shape pull-down menu and the size in the Brush 
Length (Diameter) X, Brush Length (Diameter) Y and Brush Length 
(Diameter) Z boxes. The brush size is given in voxels. 

The brush shape can be a Box, 
with the side lengths entered in 

Brush Length X, Y, and Z, or a 
Sphere / Ellipsoid with the 
diameters entered in Brush 

Diameter X, Y, and Z. The shape 
and size of the brush will be the 

shape and size of the GAD objects 
that you paint in the structure. 

The Material ID of the material to 

draw with is chosen from the 
Material ID pull-down menu.  

The choice of Brush Mode in the 
pull-down menu determines the 

working technique for the brush. 
With Set, the original material ID 
of the painted voxels is replaced by 

the selected material ID. With Add 
and Subtract, the chosen material 

ID is bit-wise added to or 
subtracted from the original 
material ID. Use Replace, to 

select a Replace ID. Only the 
Replace ID is changed to the new 

material ID. Read more on the 
brush modes below on page 80 
ff.). 

The Draw Mode defines whether the brush stroke is applied for Continuous 
drawing, for a Single Click or for drawing a Straight Line. 

4. The brush strokes, in the selected shape, size, and Material ID (here Sphere 
(Ellipsoid), diameter 5 x 5 x 10 voxels, Material ID 03), are applied by pressing 

and moving (for Continuous Drawing and Drawing Straight Lines) and by 
clicking (for Single Click Drawing) with the left mouse button in the desired 

position.  

Paint at different spatial locations by selecting a different Direction (X, Y, or Z) 
and/or a different Slice in the View Controls panel, above the Visualization area.  
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DRAW MODES 

For Draw Mode Continuous, press the left mouse button while dragging the 
mouse.  

 

Use Draw Mode Single Click by clicking the left mouse button in different locations 
of the 2D view of the structure model. The effects of editing (in 2D view) are observed 

as soon as the left mouse button is released. You can also switch to 3D rendering to 
see and control the changes made. 
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Use Draw Mode Straight Line by clicking the left mouse button and drawing the 

line to the desired end point while holding the mouse button clicked.  

 

BRUSH MODES 

While painting in the structure different material intersections occur, where the 
material ID is changed in different ways. This is shown in the next example. To better 

observe material intersections, the GeoDict built-in red-green-yellow-blue color 
scheme is used.  

This color scheme is obtained by selecting 

Settings → Color & Visibility Settings… and 

clicking the  icon at the bottom of the dialog 
(Load built-in default settings). 
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For this example, two slabs were created with 5x20x5 voxels each. The painting is 

done in the X-Y-plane on slice 12. 

 

In Set mode, all original material IDs are set  to the chosen Material ID. The 
replacement of material is clearly seen in 3D rendering:  

 

In Add mode, the selected Material ID does not replace the original material ID of 
the painted voxels, but an intersecting material is built. The new material ID is 

determined by bitwise adding the paint material ID to the material ID of the painted 
voxels. 

According to GeoDict’s rules on defining new material IDs for intersecting materials 

(see below on page 83), adding voxels of material ID 04 (blue) to material ID 01 (red) 
results in intersected voxels of material ID 05 (violet-colored). Material ID 04 added 

to material ID 02 (green) results in intersected voxels of material ID 06 (cyan-
colored). And Material ID 04 added to Material ID 00 (porous space) results in Material 
ID 04. The intersecting materials are also shown below in 3D rendering. 
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In Subtract mode, the selected Material ID is bit-wise subtracted from the existing 
structure where the brush is applied (see below page 83).  
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In Replace mode, the selected Material ID replaces only voxels with the Replace ID. 

Other Material IDs are unaffected by the modification. With the settings shown only 
voxel of material ID 01 replaced by material ID 04. 

INTERSECTING MATERIAL IDS FOR ADD AND SUBTRACT MODES 

With the GeoDict built-in color settings, 256 Material IDs are available. 

In Add and in Subtract edit mode, when two materials are added or subtracted, the 
Material ID of the addition or the subtraction is given by adding or subtracting the 
binary codes corresponding to the Material IDs. The used calculation rules are shown 

below. 

 

 

 

 

 

The addition or subtraction of Material IDs is done column-wise, as follows: 

 

 

 

 

 

Binary addition rules  Binary subtraction rules 

1 + 1 = 1  1 - 1 = 0 

1 + 0 = 1  1 - 0 = 1 

0 + 1 = 1  0 - 1 = 0 

0 + 0 = 0  0 - 0 = 0 

0 0 0 1 
 

+ + + + + 

0 0 1 1 
 

= = = = = 

0 0 1 1 
 

0 0 0 1  

- - - - - 

0 0 1 1  

= = = = = 

0 0 0 0  
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Examples of Material ID and binary codes of intersection materials obtained by 

adding: 

First material Second material Intersection material 

Material ID 
Binary 
code 

Material ID 
Binary 
code 

Material ID Binary Code 

 0010  0100  0010 + 0100 = 0110 

 0011  0100  0011 + 0100 = 0111 

 0011  0101  0011 + 0101 = 0111 

 0101  0001  0101 + 0001 = 0101 

Examples of Material ID and binary codes of intersection materials obtained by 
subtracting are: 

First material Second material Intersection material 

Material ID 
Binary 

code 
Material ID 

Binary 

code 
Material ID Binary code 

 0001  0001  0001 – 0001 = 0000 

 0101  0010  0101 - 0010 = 0101 

 0010  0001  0010 - 0001 = 0010 

 0100  0001  0100 – 0001 = 0100 
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METROLOGY 

With the Metrology functionality, distances and angles can be measured in the 2D 
View of a structure.  

Select View → 2D Cross Section (SEM) in the 

menu bar. Click the Metrology tab on the GUI 
sidebar to open the Measure Angles and 

Distances dialog. The measurement mouse mode 

is activated with the  icon from the toolbar, which 
also opens the Measure Angles and Distances 
dialog. The Metrology tab is greyed out and not 

accessible when the structure is viewed in 3D 
rendering. 

In the Camera tab of the View Control panel, 
choose the Direction (X, Y or Z) and the Slice of 
the structure for the measurement. 

To start a new measurement, first select from the 
New Measurement Settings if a Distance, an 

Angle or Angle and Distance should be 
measured. 

In the Editing Settings part of the panel, choose 

Lock Measurements to move the whole line of a 
measured distance and/or angle to another 

location. If Lock Measurements is unchecked, the 
end point of a measurement can be modified. 

Next, in Snap to grid, define if points should be 
selected freely in the structure (Free Placement), 
or be snapped to the nearest Voxel Centers, 

Voxel Corners, or Edge Centers. This means that 
when you click into the structure the nearest voxel 

center, voxel corner, or edge center (depending on 
the selection) is set as starting point for the 
measurement. 

In the Visualization Settings, choose the Line 
Thickness and Color for the visualization of the 

measurement. This can also be done after the 
measurements were conducted and it applies to all 
measurements. The font size of the measurements 

can be changed in the visualization settings sidebar. 

To start measuring, click with the left mouse button 

at the position where the measurement should be 
started and left-click again at the desired end point. 
If the measurement should be canceled, just click 

the right mouse button.  
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In the example shown here, the 

diameter of the red fiber in X-
direction is measured. 

The differences between the snap 

options can be observed if the 
visibility of the grid is turned on. 

Look at the start or end points of the 
measurements to detect the 
difference. If a Snap mode is active 

the measurements are more precise 
than placing the points by hand (Free 

Placement). 

Each measurement gets a number and all of them are 
listed in the drop-down menu under Active 
Measurement. The last measurement is usually the 

active one, but you can choose a previous measurement 
from the list or by clicking on the endpoints of the 

measurement in the visualization area.  

Below, the measured distance and/or measured angle is 
shown.  

Check Hide to hide the measurement and the text in the 
visualization area, uncheck Show Distance to hide only 

the text of distance measurement, or uncheck Show 
Angle to hide the text of the measured angle. The angle 
is measured and shown counterclockwise, when 

Counterclockwise Angle is checked. Uncheck to switch 
measuring and visualization to Clockwise, there is no 

need to redo the measurement. 
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With Delete Measurement, the currently active measurement is deleted from the 

panel. 

Clicking Adjust Voxel Length opens a dialog to change the voxel length of the 
structure accordingly to the measured distance. Enter the desired length of the 

measured line (in the example 8.5 µm instead of the 8 µm measured in Measurement 
1) and click OK. The voxel length of the whole structure is rescaled to match the 

desired length. Check Rescale all volume fields, to rescale also the volume fields 
to the new voxel length. 

 

The old measurements remain in the structure and their metrical position is 

maintained. But due to the adjusted voxel length, the voxel position of the 
measurement changes. 

In the All Measurements part of the panel, all available measurements can be 
hidden by checking Hide All or deleted with Delete All Measurements. 

 

The measurements can also be saved in a *.gdr file by clicking Save Measurements. 
A dialog opens, where you enter the desired result file name.  
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For the example we create a second measurement, this time measuring the length of 

the gray fiber segment and its angle to the X-axis. For this, set the options for this 
new measurement to Angle and Distance. As snap mode Snap to Voxel Corners 
was chosen. 

First, the desired distance is measured, then this measure line is taken as first angle 
leg, and the angle can be measured with a third click. 

 

Unchecking Counterclockwise Angle changes the visualization and value of the 

measured angle. 

 

Edit a selected measurement with a right click on one of the endpoints. The selected 

point can be snapped to the grid as explained above. The measured distance is 
adapted accordingly. The options Hide, Adjust Voxel Length, and Delete Measurement 

are the same as explained above. If needed, you can Copy the Distance in meters 
to the clipboard. 
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CONSOLE AND NOTIFICATIONS 

The console and notifications panels are located at the bottom of the GUI, under the 

visualization area. The Console panel is a textual GUI window and log viewer. The 
console allows you to read the system logs, help find certain ones, monitor them, and 

filter their contents. Additionally, you can enter and execute python commands 
directly in the console. For more details, see the GeoPy Scripting handbook.  

The console panel can be folded and unfolded by clicking on the   icon. 

When expanded, the panel can be un-docked and turned into a dialog that can move 

around. Undocking is done by clicking the  icon, located at the top right after 

expanding. The console can also be closed by clicking on . 

 

The Notifications panel can be opened and closed in the same way by clicking on 

the  icon.  

 

A right click in the console panel provides further 

options to filter and read the information 
displayed. Text in the console can be marked with 

the cursor and exported to another program by 
using Copy. With Select All the whole text in the 
console is marked. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Automation&release=2024
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Check the boxes to Show GeoDict Messages, Show GeoDict Output, Show 

GeoPython Messages and Show Solver Messages. During each GeoDict session 
a log file, that contains all outputs from the console, is written and saved in 
%username&/geodict2024/log (Windows) or %username%/.geodict2024/log 

(Linux). With Open Log File it is opened in the chosen text editor (see page 26 ff.). 
Use Zoom in and Zoom out to enlarge or reduce the font size of the console. 

Messages from GeoDict, which are shown in the console, are also shown in the 
Notifications panel.  

 

The list shows the Time, when a message was raised, the icon shows the Type of 

the message, also the Title and the Message itself are given. The message is fully 
displayed in the tooltip, which opens when resting with the cursor over the message. 

With a right click in the corresponding field the title and the message text can be 
copied to the clipboard to save them e.g. in a text editor. This is helpful, when a 

message box was closed, and the user wants to re-read the message. Another 
advantage is, that you do not have to scroll through the console, where other output 
from GeoDict is listed. 

With the filter options it is possible to show only Critical Errors, Warnings and/or 
Information. Click on Clear Notifications to delete all messages from the list. 
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